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Liability exclusion
You have acquired a kit which can be assembled into a 
fully working robot when fitted out with suitable acces-
sories. However, we as manufacturers have no control 
over the way you build and operate your model, nor how 
you install, operate and maintain the associated compo-
nents, and for this reason we are obliged to deny all li-
ability for loss, damage or costs which are incurred due 
to the incompetent or incorrect use and operation of our 
products, or which are connected with such operation in 
any way. Unless otherwise prescribed by binding law, the 
obligation of the GRAUPNER company to pay compen-
sation, regardless of the legal argument employed, is ex-
cluded. This includes personal injury, death, damage to 
buildings, damage due to loss of business or turnover, 
interruption of business or other direct or indirect conse-
quent damage whose root cause was the operation of 
the model.
The total liability in all cases is limited to the amount of 
money which you actually paid for the kit.
This model is built and operated at the sole and express 
responsibility of the operator. The only way to avoid injury 
to persons and damage to property is to handle and ope-
rate the robot with the greatest care and consideration at 
all times.
Before you operate the RB1000 for the first time it is im-
portant to check whether your private third party liability 
insurance policy covers you for operating models of this 
type. If you are not sure, take out a special policy desig-
ned to cover the risks inherent in RC modelling.
These Safety Notes must be kept in a safe place. If you 
ever dispose of the model, be sure to pass them on to 
the new owner.

The sole purpose of this manual is to provide informati-
on. We reserve the right to alter the information without 
prior notification, and it must not be viewed as an obliga-
tion on the part of the GRAUPNER company. GRAUP-
NER accepts no responsibility or liability for errors or 
inaccuracies which may occur in the information section 
of this manual.

Epilepsy warning
Please read through this information before you use the 
software, or allow your child to operate it.
When subjected to particular flashing lights or lighting 
effects, many people may be susceptible to epileptic 
fits or other mental upsets, and it is possible that such 
individuals may be affected when using computer pro-
grams. Even persons whose history of illness does not 
include epilepsy, and who have never suffered a fit, may 
be affected by this problem. If you or a family member 
have ever noticed symptoms which might be connected 
with epilepsy (such as mental upsets or fits) under the 
influence of flashing lights, please seek medical advice
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  180° arc of travel. This can and will cause perma-
  nent damage to your servos - adjust the axis
  values immediately to prevent this happening!

Components and accessories
GRAUPNER GmbH & Co. KG, as manufacturer of this 
model, recommends that you use components and ac-
cessories which have been tested and approved by 
GRAUPNER for their suitability, function and safety. The 
company accepts product liability if you observe this 
advice. GRAUPNER does not accept liability if you use 
unapproved parts or accessories made by other manuf-
acturers, as we are not in a position to assess every in-
dividual product made by other companies for their sui-
tability and safety.

Optional accessories
This manual also describes and explains the use of va-
rious optional accessories which are not included in the 
kit. Naturally, the software already supports these appli-
cations; there is no need to purchase additional upgra-
des.

The optional features are:
• controlling the robot using a transmitter and receiver;
• the use of gyro sensors;
• the use of the digital outputs for various consumer
  units such as LEDs.

System requirements
Operating system: Windows XP
Processor:  Min. Intel Pentium 4, at least
    1 GHz
Working memory: Min. 128 MB
Interface:  1 x RS 232 serial port
Other:   CD-ROM drive.

Serial interface
The following illustration shows the standard commer-
cial 9-pin serial port on a PC. Next to it is the correspon-
ding socket on the CPU board.

before you use this software. As a basic rule, parents 
should always supervise their children when they are 
using computer programs. If you or your child should 
encounter symptoms such as dizziness, vision pro-
blems, eye or muscle twitches, loss of consciousness, 
disorientation, or any kind of involuntary movement or 
cramp when you are using a computer program, switch 
the machine off immediately and consult your doctor 
before you resume working on the PC.

Cautionary measures when using the software:
• Do not stand or sit too close to the computer screen.
• Use a flicker-free screen as the computer display.
• Do not carry out programming when you are tired, or
   if you are short of sleep.
• Ensure that the room in which you carry out
   programming is always well ventilated.
• When using any computer program, take a break
   at least every hour; it should last a minimum of ten to
   fifteen minutes.

General Information
It is important to start by reading right through Part 1 
(General Information and Hardware) of the Operating 
Instructions. Please read and observe all the war-
nings, safety information and operating notes inclu-
ded in the hardware manual as well as those in this 
software manual. Please note that the terms “servos” 
and “axes” always refer to the robot’s joints.

Warnings, Safety Notes
• These instructions cannot and do not cover problems
   and queries specific to the PC or its operating system.
• We accept no liability for problems and damage which
   are caused by improper use of the RobovieMaker
   software on your PC system.
• We are unable to guarantee that any particular USB
  - serial RS232 adaptor will work correctly, since not all
   these devices communicate properly with the ro
   bot and / or with the PC. However, there is nothing in
   principle to prevent you using such adaptors if your
   PC system does not feature a serial port.
•  It is never possible to exclude the possibility of
   malfunctions with software products.
• Avoid programming sequences which involve very
  fast, violent movements, as they are very hard on
  servos and mechanical systems. The result may be
  premature wear of these components.
• The programs supplied may cause damage to your
  robot if it is not assembled and adjusted very
  accurately.
• It is never possible for any axis to move over its
  full theoretical range of 0 to 255. If you change axis
  values, and a servo no longer moves despite not
  being stalled, then you have exceeded the servo’s
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This section describes the method of using the Robovie-
Maker software in order to “bring your robot to life”.

1. Place the supplied CD-ROM in your CD drive and
     copy the complete “RobovieMaker” folder to the hard
     disc of your computer.
2. The software does not need to be installed. To start
     the program all you have to do is double-click on the
     file :\RobovieMaker\RobovieMaker.exe.
3. The program is pre-configured; this means that, once
     you have started it, the only parameter which has to
     be set is the communication interface, i.e. the COM
     port on your PC through which you wish to com-
     municate with the robot. You can find the port num-
     ber by checking the Control Panel on your computer.
     The following illustrations show this clearly:

4. The communication sockets vary from one PC sys-
      tem to the next; the illustrations above therefore
      serve only as an example, to help you set up the
      COM port in the RobovieMaker software correctly.
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Start page buttons

Setting the COM port
The COM port must be set correctly, otherwise commu-
nication between the robot and the PC will not be pos-
sible. In the previous section you established which port 
is available for the communication link. We now explain 
how to select the corresponding port in the RobovieMa-
ker software.
Start the program, click on the “Settings” button and 
switch to the “Settings” tab. In the “System and Screen” 
section you can now change the COM port using the ar-
row keys.

“New” button
Creates a new motion sequence.

“Open” button
Opens a motion sequence.

“Save” button
Stores the current motion sequence.

“Undo” button
Reverses the actions just carried out.

“Redo” button
Restores actions after they have been reversed.

“Copy” button
Copies the marked objects.

“Paste” button
Pastes the copied objects.

“Copy left to right” button 
Copies axis positions from left to right

“Copy right to left” button
Copies axis positions from right to left.

“Change left and right” button
Interchanges right and left axis positions.

“All axes to Neutral-Position” button
Sets all axes to the Neutral-Position.

“Insert Between-Position” button
Inserts an intermediate position between the axis values.

“Insert Copy” button
Inserts a copy of the current axis values.

“Delete” button
Erases the marked axis position.

“Delete Prior” button
Erases the previous position on the axes.

“Start” button
Starts the programmed motion sequence.

“Stop” button
Halts the motion sequence once started.

“Next step with loop” button
Carries out the next step of the sequence, including loop.

“Next step without loop” button
Carries out the next step of the sequence, excluding loop.

“Settings” button
Opens the Settings menu.

“Servopower On / Off” button
Switches the servo power supply on and off.

“Propo mode” button
Opens the Propo mode menu.

“Automatic mode” button
Opens the Automatic Mode menu.

“Write files to CPU board” button
Opens the program download menu.

“Connect / Disconnect” button
Switches communication to the CPU board on and off.

“Repeat loop” button
Sets the number of loop iterations

“Accept current pre-set 
time” button

Accepts the pre-set time for all positions as a percentage.

Once you have set the correct number, click on the “Apply 
and save” button and close the menu by clicking on the 
button of the same name. Everything is now prepared, 
and you should be able to complete the connection to 
the robot.
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Completing the connection
1. Connect the CPU board to your PC using the serial
    interface cable supplied in the set.
2. Move the operating mode DIP switches to the
    position shown below.

3. Switch on the power supply to the CPU board.
4. Press the black Reset button adjacent to the DIP
    switches.
5. Click on the “Connect / Disconnect” button.
6. If an error message appears, check the settings of 
    the COM port, the interface cable, the power supply
    and the DIP switch settings.

Moving all the servos to their installation position
All the servos (axes) must be brought to their correct 
position before the components of the robot can be as-
sembled correctly. This is the procedure, step by step:
1. Complete the connection to the CPU board, as
    described above.
2. Check the Neutral-Position values by clicking on the
   “Settings” button, followed by the “Neutral-Position”
    tab, as shown below. While you are there, check the
   “Reverse” buttons!

3. If you find deviations from the values shown, adjust
    them using the appropriate arrow buttons. If you
    have selected the “Reverse” function for any axis, the
    values for the axes will not coincide with those on the
    start page. This is caused by a function which facilita-
    tes symmetrical movements; more details on this
    later.
4. Click on the “Apply and save” button.
5. Click on the “Write setup to CPU board” button to
    load the corresponding data into the robot.
6. Re-connect the robot to the CPU board by clicking
    on the appropriate button.
7. Caution: when you reach Point 8, all the servos
    will move at full speed to their installation
    position. Before you do this, please read the
    Warnings and Safety Notes in both sections of 
    the Operating Instructions.
    Injury hazard!
8. Click on the “Servopower On / Off” button. All the
    servos will now move to their installation position.
    If any servo emits a loud noise or becomes hot,
    switch off the servo power supply immediately,
    then check the wiring and the installation.
9. If all is well, the servo power supply can now be swit-
    ched off again, and the robot disconnected.

Of course, as an alternative you could adjust the neutral 
position of the servos to suit your own ideas and pre-
ferences. However, if you do this please note that the 
pre-programmed routines will no longer work properly; 
the robot could also be damaged if you choose unsuitab-
le positions.

Notes
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Fine adjustment of the neutral position
Caution!
- Errors in the assembly process could cause cer-
  tain axes to run against their mechanical end-stops
  when the servo power supply is switched on.
- Check the freedom of movement of all axes when
  you switch the servo power supply on. If any servo
  emits a loud noise or becomes hot, switch the ser-
  vo voltage off immediately, and check that you
  have assembled the model correctly. If you neglect
  to do this, the result could be damage to servos
  and other robot components.
- If you are satisfied that all axes have ample free-
  dom of movement, it is safe to start the fine adjust-
  ment process as described in the next section.
- Keep your fingers well clear of the robot when its
  axes are in motion!

Your robot is now completely assembled, and is ready 
for “crossing the final ‘t’” in terms of adjustment. This 
stage is important: the more accurately you carry out the 
procedure, the easier and smoother will be the sub-
sequent programming of the robot; the model will also 
process the supplied motion sequences accurately if the 
fine adjustments are correct.
The final stage of fine-tuning is carried out using the 
adjustment template, as already mentioned in Part 1 of 
the Operating Instructions; the template is also shown in 
the illustrations.

1. Open the “Fine adjustment of neutral position” tab
    in the “Settings” menu, as shown below. The illustra-
    tion shows a robot which has been adjusted accura-
    tely; for the initial stage of adjustment the value “0” is
    assigned to all the axes.
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2. Complete the connection to the robot, and switch the
    servo power supply on.
3. Move all the robot’s axes to the correct positions
    using the arrow buttons. The neck and arm axes can-
    not be set up correctly using the adjustment template;
    adjust these axes to the positions shown in the pic-
    tures of the robot in the software, taking care to keep
    everything symmetrical (the same on both sides).

4. When you have adjusted all the axes accurately, click
    on “Apply and save” to store the data and write it to
    the CPU board. This is carried out using the two but-
    tons marked “Apply and save” and “Write setup to
    CPU board”.

- If you wish to reverse the adjustments you have made,
  click on the “Reset settings” button.
- The “Apply” button accepts the current settings; they
   are not stored when you terminate the program.
- If you wish to read out the current setup, click on the
  “Read setup from CPU board” button.
- This tab also allows you to rename the axes and
  select / de-select particular axes.



4. RobovieMaker

8     RobovieMaker - Operating modes - Servo positions - Neutral position - Checking axis assignments

Operating modes
Your robot can be operated using any of the following 
operating modes; they are selected using the DIP swit-
ches located on the CPU board.

PM

A1

A2

A3

A4

1. When all the DIP switches are in the “up” position, as
    described in the section entitled “Completing the con-
    nection”, the connection to the robot is completed. In
    this mode the model can be programmed, tested and
    adjusted. This mode of operation should always be
    selected whenever you wish to connect to the robot.
2. PM means Prop Mode (transmitter operation); in this
    mode the robot can be controlled by the programmed 
    and loaded routines using an optional transmitter and
    receiver.
3. A1 - A4 are the automatic modes 1 to 4. In these mo-
    des you can run programs automatically step by step.
    As soon as the robot is activated, the prepared
    sequence which was programmed for the
    selected mode starts up.
4. Whenever you wish to change the operating
    mode, switch the robot off first!

Servo positions
The arc of travel of each servo, or axis, is 0° to 180°. This 
range corresponds to the values between 0 and 255, va-
rying according to the Neutral-Position and fine adjust-
ment of the neutral position.
It is never possible for any axis to move over its full 
theoretical range of 0 to 255. If you change axis va-
lues, and a servo no longer moves despite not being 
stalled, then you have exceeded the servo’s 180° arc 
of travel. This can and will cause permanent damage 
to your servos - adjust the axis values immediately to 
prevent this happening!

Neutral-Position
The robot’s position which you set in the section descri-
bing the fine adjustment of the neutral position is exactly 
that: the neutral-Position. All programmed movements 
now start from this position. If you have set up the Neu-
tral-Position correctly, it will be possible to run programs 
developed using other RB1000 models without any pro-
blem.

Checking the axis assignments
Now that you have become familiar with the basic ope-
ration of the software, you should be in a position to test 
your robot and check whether you have assembled it cor-
rectly. This is the basic procedure:
1. Starting from the basic image, complete the connec-
    tion to the robot (by clicking on the appropriate button).

2. Check the axis values set in your software,
    comparing them with the illustration above.
3. When you switch on the servo power supply
    (by clicking on the button), all the servos will
    move to their Neutral-Position.
    Take care to avoid injuring yourself!
4. Switch the servo power supply on, and you will hear
    the servos respond. If any of the servos should
    become hot or emit a loud hum or buzz, switch
    the power supply off again. Of course, this applies
    any time you are operating the robot!
5. Now try altering the servo values one by one using
    the red and green arrow buttons, and check that all
    the servos have ample freedom of movement to a
    position just short of their mechanical end-points.
    This procedure also allows you to check the
    correct axis assignments.
    After a little practice you will find that holding down
    the Shift key on your keyboard enables you to alter
    the values in increments of 10 units.
6. Never allow the servos to strike their
    mechanical end-stops!

We recommend that you use this procedure to practise 
handling the software and familiarise yourself with the 
various axes of your robot. You can also try clicking on 
“Connect / disconnect” to open and close communication 
with the robot, and switching the servo power supply on 
and off; in this way you will eventually begin to feel “at 
home” with the program interface.
If you change values with the servo power supply 
switched off, no axis movement will occur!



4. RobovieMaker

RobovieMaker - My first movement    9

My first movement
This section describes the procedure for creating and 
testing motion sequences. In order to carry out these pro-
cedures, you must already have adjusted the robot and 
checked its freedom of movement.

Axis area

Motion area

Axis-Servo-Joint slider

Axis number

Axis position with arrow buttons for altering values

Axis position change slider

Axis Neutral-Position

Position slider in the motion area (step)

Turns red when position is active

Position number (step)

Pre-set position time

Pre-set time value x 20 ms

Next position number or step number

Jump out marker for a programmed loop

Motion sequence
- It makes sense to assign the neutral position to the
  first and last steps of a motion sequence, as this
  ensures that the robot always commences its
  sequence from the same starting point.
- One step in the movement range always contains all
   the positions of all axes.
- If you create Between-Positions and Copies of
  positions using the appropriate buttons, they are
  always added after the active position.
- When setting up loops, always define a jump out
  marker that is higher than the position number,
  otherwise the result will be an endless loop.
  One loop structure can be programmed for each
  motion sequence.
- The maximum number of positions per motion
   sequence is 100.
- Axis positions can be interchanged by adding them
  between the positions of a motion sequence.
- Read the section entitled “Buttons on the start page”
  very carefully, as this is the key to exploiting all
  the software’s facilities to the full.
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Loop structure
The previous section mentioned the creation of a motion 
sequence. At this point we will explain the basic potential 
of loop structures.

Program sequence
After starting the program, e.g. by clicking on the “Start” 
button with the connection completed and the servo po-
wer supply switched on, or using programmed Propo 
mode, keyboard mode or automatic mode, the steps are 
processed in turn, producing the following servo positi-
ons:

Step  00: (ideally the Neutral-Position) moves all axes to
                the programmed positions in 048 x 20 ms
    = 0.96 s. Step 01 is then processed;
                no loop is present.
Step  01: moves all axes to the programmed positions
    in 075 x 20 ms = 1.5 s. Step 02 is then
                processed; no loop is present.
Step  02: moves all axes to the programmed positions
                in 041 x 20 ms = 0.82 s. Step 03 is then
                processed; no loop is present.
Step  03: moves all axes to the programmed positions
                in 059 x 20 ms = 1.18 s. Step 04 is then
                processed; no loop is present.

Step  04: moves all axes to the programmed positions
                in 133 x 20 ms = 2.66 s. Step 01 is then
                processed; this is carried out three times,
                after which step 05 is processed
                (jump out marker).

Step  05: moves all axes to the programmed positions
                in 037 x 20 ms = 0.74 s. Step 06 is then
                processed; no loop is present.
Step  06: (ideally the neutral position) moves all axes
                to the programmed positions in 067 x 20 ms
                = 1.34 s. The motion sequence is concluded.

“Sequence” menu
The first motion sequences can be started, stopped or run 
through step by step using the “Sequence” menu, or by 
clicking on the appropriate buttons, provided that the ro-
bot is connected and the servo power supply is switched 
on. If you select “next step, no loop” for the function se-
quence, any programmed loop structures are skipped.

“File” menu
The created motion sequences can be stored using the 
“File” menu or the appropriate buttons. The same menu 
is also used to open or save existing sequences.

“Edit” menu
The motion sequences you have created can be pro-
cessed using the “Edit” menu, by clicking on the appro-
priate buttons or by clicking with the right mouse button. 
You will find a description of the start page button func-
tions in an earlier section.
When copying or exchanging positions from the left or 
right side, the software processes the axis positions of 
the left and right side of the robot. This is possible becau-
se the corresponding axes on the left and right sides are 
marked as a “pair” in the def.ini file.
The “Reverse selected axis” function simply switches (re-
verses) the display of the selected axis values.

“Position” menu
When creating motion sequences, you can create or era-
se positions using the “Position” menu, by clicking on the 
appropriate buttons or by clicking the right mouse button. 
You will find a description of the start page button func-
tions in an earlier section.
If you insert an Between-Position after a set positi-
on, then the travel of the Between-Position is always 
half-way between the preceding and succeeding axis 
positions!

“Tools” menu
Extra (non-standard) functions can be carried out using 
the “Tools” menu, by clicking on the appropriate buttons 
or by clicking the right mouse button. You will find a de-
scription of the start page button functions in an earlier 
section.
It is also possible to read out the firmware version of the 
CPU board, change the background pictures of the axis 
and motion areas, and load a different initialisation file 
(def.ini). Amongst other data, this file contains the Neu-
tral-Positions, the axis names and the “fine adjustment” 
values.
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Propo mode
Propo mode is started from the “Tools” menu or by cli-
cking on the appropriate button.
In this menu you can alter various aspects of the robot’s 
functions:
1. Controlling the robot using an optional transmitter
    and receiver.
2. Controlling the robot using the keyboard.
3. Defining the response when the robot is lying on belly
    or back position.

Right stick

Click on the “Browse” button to assign a stored motion 
sequence to a particular stick position. Clicking on the 
“Delete” button erases this assignment again. “Neutral” 
means: no transmitter signal.

Left stick

Click on the “Browse” button to assign a stored motion 
sequence to a particular stick position. Clicking on the 
“Delete” button erases this assignment again.
The letters in brackets indicate the key assignment if you 
wish to start the motion sequences from the keyboard.

Switches 1 and 2

These switches enable you to switch the assignment of 
the left and right stick nine times. This works in the same 
way as the optional two-channel switch modules on the 
transmitter. Since it is possible to assign eight positions 
to the right stick and five positions to the left stick, the 
option of switching nine times generates a total number 
of 117 motion sequences which can be initiated from the 
transmitter!

Attitude sensor

If the robot is connected, the current values of the attitu-
de sensor are displayed in the range of that name. If you 
wish to make use of the sensor feedback, you can select 
this option by clicking on the appropriate check boxes. It 
is also possible to pre-set the sensor value at which the 
selected program is to start.
The “Save” and “Load” buttons can be used to store and 
load the entire Propo mode.

Keyboard number block

The illustration shows the key assignment if you wish 
to start the right stick motion sequences from the key-
board:   8     --> forward
   4     --> left
   2     --> back
   6     --> right
   4+8 --> left forward
   4+2 --> left back
   6+2 --> right back
   6+8 --> right forward

If you wish to initiate Propo mode from the keyboard, 
you must first complete the connection to the robot, and 
switch on the servo power supply. Click on the “Start” but-
ton to initiate “keyboard mode”, and you can then call up 
the appropriate motion sequences. Clicking on the “Stop” 
button concludes the keyboard control mode.

- A motion sequence can only be started when the
  preceding sequence is concluded. This applies to
  Propo mode and keyboard mode alike.
- The attitude sensor is an integral part of the CPU
  board; that is the reason why the CPU board must be
  installed exactly as described in the instructions,
  otherwise the sensor values would be incorrect.
- When you are using keyboard mode, make sure
  there is sufficient freedom of movement for the
  serial interface cable.
- It makes sense to assign a movement to the
  “Neutral” field of the right stick which only contains
  the Neutral-Position.
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Automatic mode
The menu for creating various Automatic modes is ope-
ned in the “Tools” menu, or by clicking on the approp-
riate button. Automatic modes contain various motion 
sequences which have already been created. These se-
quences can be cascaded (linked together) and repeated 
as often as you like.

- Motion sequences can be added and erased using
  the “Browse” and “Delete” buttons. A new sequence
  is always added after the currently active sequence.
- Automatic modes can be stored or loaded using
  the “Save” and “Load” buttons.
- When you initially select a sequence, you can also
  determine how many times it is to be repeated.
  This is defined in the “Repeats of motion” range.
- The “Connect / Disconnect” and “Servopower On / Off”
  buttons are used for testing a programmed
  Automatic mode. When carrying out such tests,
  make sure that there is sufficient freedom of
  movement for the serial interface lead.
- If you wish to test the Automatic mode, you can
  enter the number of repeats of the whole Automatic
  mode in the “Total repeats for test” range. If the robot is
  no longer connected for the testing procedure, the
  selected Automatic mode will be carried out once.
- During testing, the “Start”, “Pause”, “Stop” and
  “Next” buttons are used to control the Automatic
  mode when the robot is connected.

The illustration shows an Automatic mode in which the 
program Hello.txt is initially completed three times, after 
which the program Wave_hands.txt is processed once. 
The folder containing these motions is also stated.

Writing programs to the CPU board
The menu for downloading the Propo mode and Auto-
matic modes 1 - 4 is opened in the “Tools” menu, or by 
clicking on the appropriate button.

The “Browse” and “Delete” buttons can be used to write 
information to the CPU board in the form of stored Auto-
matic modes and the configuration of a Propo mode. If 
you also wish to write the setup of the CPU board, this 
can also be selected. Naturally, the robot must be con-
nected for this process.
Once you have written the data to the CPU board, you 
must then switch the robot off in order to set the desired 
operating mode. If you select transmitter mode, always 
switch the transmitter on first, and then the robot. If you 
then switch the robot on with the desired operating mode 
set, the robot’s own programming then starts immedia-
tely.
Caution!
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Settings
The “Settings” menu can be opened via the “Tools” menu 
or by clicking on the appropriate button. The following 
ranges can be adjusted using the “Settings” tab

Digital Output
It is possible to generate four voltages in the range
0 - 5 V, which can be adjusted in 20 mV increments.
The voltage level is the mean value of a rectangular vol-
tage.

Use the check boxes to activate the output you wish to 
use; its Neutral-Position is determined in the correspon-
ding range. In our example only output 1 is activated, 
with the Neutral-Position of 0. This means: if you add a 
position, the value of the output is automatically 0 V (this 
does not apply to a copy!). 

The illustration shows this output in the axis area; a diffe-
rent value can be applied at any position. In this case the 
voltage is 121 x 20 mV = 2.42 V. The maximum current is 
around 15 mV at the TTL level.
The output arrangement can be found in the Hardware 
section of the Operating Instructions.

System and Screen

- The check boxes can be used to select whether
  you wish to display a background image in the axis
  and motion area.
  The individual axis values can be displayed as
  offsets + or - relative to the current Neutral-Position.
- The update rate of the display in the servo range can
  be adjusted using the slider. If your PC system is
  slow, be sure to set an appropriate value.

If you wish, you can replace the background pictures of 
the axis and motion area with your own images. The pic-
tures shown here are the originals. Be careful with the 
size of the bitmap; it should be the same as the original 
image.



Gyros
Two optional gyro sensors can be fitted to the robot. The method 
of connecting these sensors to the CPU board is described in the 
Hardware section of the Operating Instructions.

- Once you have connected the gyro sensors to the
  CPU board, and the robot is already connected, you
  can calibrate the sensors by clicking on the
  “Apply” button.
- Activate the corresponding sensor using the check
  boxes, and determine its neutral position.
- You then have to use the appropriate tab to enter
  the socket (servo output) on the CPU board to
  which the gyro sensor is connected.

In our example a gyro sensor is connected to socket 14, 
and is set to the neutral position 0.

It is now necessary to activate the servo output for the 
gyro sensor using the “Fine adjustment of the neutral po-
sition” tab; the following illustration shows this clearly.

You can now program an offset for each of the gyros 
using the “Gyro offset values” tab. The further the sensor 
is moved from its idle position, the more pronounced its 
effect on the servos.

14     RobovieMaker - Gyros
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The permissible range for the offset values is -128 to 
+127.

These settings can now be written to the CPU board by 
clicking on the appropriate button.

For each position it is possible to program the extent to 
which the gyro sensor feedback is required to affect the 
movement.

At this position the gyro sensor feedback will affect the 
position with a strength of 105. The illustration also shows 
the neutral position 0 and the servo output 14.

Using this procedure motion sequences can be refined 
and optimised using the gyro sensors. 

If you do not wish to use feedback for part of a move-
ment, i.e. you want the axes to act solely in accordance 
with the fixed programming, simply set the value in the 
top picture to 0 for these positions.

Naturally, the installed position and attitude of the gyro 
sensors is very important, as these aspects are crucial to 
their effect on the robot’s axes. More information on this 
subject is included in the instructions supplied with the 
gyro sensors.
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The def.ini file
This file is located in the RobovieMaker program folder, 
and contains all the information for the CPU board. Ex-
perienced users can also alter the settings directly in this 
file. However, please note that the syntax you use must 
be exactly correct!

_RobovieMakerVersion[ 2 ]
  --> RobovieMaker program version

_SerialportNumber[COM1]
  --> Number of the serial port for communication

_MinimumTransitionTime[4] 
  --> Minimum possible time for reaching a position

_DrawMotionareaBG[ TRUE ]
  --> Display motion area background

_DrawPoseareaBG[ TRUE ]
  --> Display axis area background

_RelativeMarkOfAxisParam[ FALSE ]
  --> Display of axis values as neutral setting offset

_PoseareaRedrawRate[ 2 ]
  --> Servo range update rate

_AxisNumber[1]
  --> Axis number

_AxisName[R_Should]
  --> Axis name

_NeutralPose[200]
  --> Axis Neutral-Position

_AxisTuningPrameter[+003]
  --> Value of the Neutral-Position fine adjustment

_GyroSetting[-010,+000]
  --> Offset values of gyro sensors 1, 2

_AxisMovableRange[000,255]
  --> Axis limit input facility

_AxisUsable[ TRUE ]
  --> The axis is used

_AxisReverse[ FALSE ]
  --> Reverse of the Neutral-Position

_AxisSymmetry[ PAIR_R ]-[15]
  --> Symmetry axis of the robot linked to axis
       15 (other side of robot)

_GS_XCenterPosition[094]
  --> Gyro sensor calibration

_GyroNeutralPosition[1] _D-I/ONeutralPosition[0]
  --> Gyro sensor Neutral-Position

_D-I/O[1]
  --> Number of the output

_D-I/ONeutralPosition[000]
  --> Neutral-Position of the output

_i/oMode[ OUTPUT ]
  --> Defined as output; do not change this!

_AxisUsable[ TRUE ]
  --> The output is used

The sidpos.dat file
This file is located in the RobovieMaker program folder, 
and contains the positions of the individual axis sliders 
and outputs. The axes appear first in the file, followed by 
the outputs.
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